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UtilityWorks is an integrated set of Apple IIGS utilities which gives the user,
within a single program, all of the most frequently needed Apple IIGS utilities. Full use
is made of pull-down menus and multiple windows. The capabilities incorporated into
UtilityWorks include:

a) Disk (device) utilities to copy, format, erase, rename, and verify entire disks.
These utilities are fully compatible with all devices and file systems supported
by GS/OS System Disk 6.0.

b) Path (directory) utilities to set and view prefixes, view directory trees, catalog
directories, generate catalog data base files, and backup and restore hard disk
files.

c) File utilities to copy, move, delete, rename, and verify files and directories.
These utilities are compatible with all file systems and file types supported by
GS/OS System Disk 6.0.

d) Display utilities to display, on a SHR screen, text, AppleWorks and AppleWorks
GS word processing, Applesoft BASIC, picture, animation (with animation),
3200 color, font, and icon files.

e) A Text Editor to edit any text based file (including AppleWorks word processing
files or your own new files). Full capability is provided to cut, paste, use the
clipboard, use any font, font size, and font style, choose font colors, and set
margins, line spacing, and justification.

f) Print utilities to print what is displayed, including the contents of windows
containing such information as catalogs and directory trees.

g) Utilities to display and print samples of all of your fonts, or display characters
associated with any key (Key Caps).

h) Utilities to load CDAs and NDAs, as well as enable or disable any CDA, NDA,
control panel, driver, or permanent or temporary initialization file.

i) Numerous miscellaneous capabilities itemized in the following paragraphs.

UtilityWorks®
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Copyright © 1988 - 1998 by George R. Wilde
24402 Broadwell Ave.

 Harbor City, CA  90710
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Installing UtilityWorks

UtilityWorks is an S16 program which must be run under GS/OS System Disk
5.0.4 or later. The file UtilityWorks.GS is the main UtilityWorks program. It can be run
out of any directory contained in any 0n-line disk. UtilityWorks no longer reads from
and writes to a configuration file (UWGS.CONFIG) contained in the SYSTEM directory
of your boot disk. Instead default configurations from the Options menu are now stored
in a resource fork of the UtilityWorks program whenever you select SAVE in the
Options menu.

Upon loading, UtilityWorks will load the required RAM based tools and begin
execution. UtilityWorks is only compatible with GS/OS System Disk 5.0.4 or later. It is
provided in ExpressLoad format for faster loading. Nine dynamic segments are also
used to minimize memory requirements and improve performance.

UtilityWorks version 2.0 and later adds several resources to UtilityWorks to
facilitate better use in conjunction with the new System 6 Finder. rIcons have been
prepared for the UtilityWorks program, the UWGS.Backup files, and all files that
UtilityWorks can open. rVersion, rComment, and rBundle resources have also been
prepared for use with the System 6 Finder. Launching UtilityWorks the first time from
the new Finder will install the UtilityWorks rBundle. After the rBundle is installed,
double clicking on any file icon produced by UtilityWorks (all UtilityWorks file icons
have a hammer at the right-hand side of the icon) from the Finder will launch
UtilityWorks and open or print the selected files.

As always make sure you install UtilityWorks on a backup copy of your System
Disk or another disk.
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UtilityWorks Capabilities

 This section describes the capabilities of UtilityWorks. When UtilityWorks
initialization is completed, the user will be presented with a menu bar and two to three
windows (unless the windows have been disabled from the Options... menu item’s
defaults dialog box). If the catalog option was selected, the bottom window contains a
catalog of the directory UtilityWorks was loaded from (prefix 9 or prefix @). The middle
window contains a list of all block devices currently active on your computer, the
names (if any) of the disks mounted on these devices, and their associated file system
(i.e.; the operating system the disks were created under). The top window lists all of the
33 current prefixes from GS/OS. As always you can click on any window to put it on
top. You can zoom the windows (most valuable with the catalog), scroll the contents if
it exceeds the size of the window, grow or shrink the windows, or drag the windows
around the desktop to suit your individual whims. You can also move lower level
windows around without making them the top window by dragging them with the
Command (Open-Apple) key depressed.

The menu bar contains eight pull-down menus, each containing several items
as delineated below. Each individual menu item will be discussed in the reference
section of this document. In 320 mode, only those menu items designated with an * will
appear.

1. Apple Icon *
- About UtilityWorks...
- Help...
- Speed Up... *
- Any NDAs you have loaded *

2. File *
- New
- Open...
- Close *
- Save
- Save As...
- Get Info...
- Copy...
- Move...
- Delete...
- Rename...
- Verify...
- Page Setup... *
- Print... *
- Launch...
- Quit *
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3. Edit *
- Undo *
- Cut *
- Copy *
- Paste *
- Clear *
- Select All *
- Grab Picture
- Show Clipboard
- Icon Editor...
- Create rBundle...
- File Editor...
- Block Editor...
- Resource Editor...
- Compare...

4. Search
- Find File...
- Find String...
- Find Again
- Search Tree...

5. Path
- Show Prefixes
- Set Prefix...
- Show Tree...
- Catalog...
- Backup...
- Restore...
- Catalog Data Base...
- Undelete...
- Remove Resource...

6. Device
- Show Devices
- Character Device...
- Deactivate...
- Copy...
- Format...
- Bulk Format
- Erase...
- Rename Device...
- Rename Disk...
- Verify...
- Bulk Verify
- Eject
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7. Utilities *
- 320 (or 640) Mode *
- Options...
- Finder Preferences...
- Computer Info.
- Show Memory
- Purge Memory
- Set File Type...
- Set File Access...
- Set File Date...
- Clear Backup Bits...
- Install DAs...
- Install Driver...
- Install Init...
- Loader Actions...

8. Document
- Edit Text...
- Select Ruler...
- Select Color...
- Select Font...
- View Fonts...
- Load Fonts...
- Print Fonts...

9. Window *
- name of first window *

.

.

.
- name of last window *

The current time is displayed at the right hand corner of the menu bar unless the
time display has been disabled in the Options... menu item. This information is
updated as long as no other activity is going on or no alert or error window is being
displayed. The current date is displayed below the time by pressing the mouse on the
time.
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A few comments are in order regarding the menus in the menu bar. The file pull-
down menu encompasses those activities related to operations on individual files (i.e.;
displaying a file, printing a file, renaming a file, etc.). This menu also includes the
capability to quit UtilityWorks, or launch another application and return to UtilityWorks
when the other application is completed. The Edit pull-down menu is used by the Text
Edit capability and many New Desk Accessories. It also includes a Compare routine, a
Block Editor, an Icon Editor, and a clipboard viewer. The Search pull-down menu has
a find file capability and a find string capability. The Path pull-down menu
encompasses those activities related to individual paths or directories. The Device
pull-down menu encompasses those activities related to entire disks or devices. The
Utilities pull-down menu, as its name implies, contains miscellaneous useful utilities.
The Document pull-down menu contains font and editing capabilities for text based
files. The Window pull-down menu displays the names of all current UtilityWorks
windows to allow easy selection of the desired front window. Each of the above pull-
down menu items is discussed in detail in the reference section of this document.

Beginning with UtilityWorks version 2.0, the appearance of all dialogs was
changed to conform with Apple’s latest Human Interface Guidelines. When System 6 is
present the AlertWindows will also conform with these guidelines.  The buttons at the
bottom of the dialog will generally have the action button on the right and the Cancel
button (if any) immediately to the left. Pressing enter or return will select the default
(bold-outlined) button (usually, but not always, the action button). Pressing esc or
Command-period will select the Cancel button if one exists. I Beam cursors will appear
if the cursor is positioned over an Edit Line item. With AlertWindow dialogs you can
type the first letter of a button name instead of clicking on it (unless some other button’s
name has the same first letter). This works with or without the Command key.

The Standard File dialog also supports keyboard equivalents with System 6.
You can use the up and down arrow keys to select various items in the list. You can
also type one or more characters (including the beginning character of an item) to
jump the selection down to that item. (To use the first several characters of an item
name, you have to type one letter every two-thirds of a second or faster). Command-
Tab moves to the next disk. Command-period is the Cancel button, but esc isn’t in the
Standard File dialogs. Esc and Command-up-arrow are equivalent to the Close button
(moving the directory one level closer to the root directory). Command-esc or
Command-D jumps to the Disks list. Clicking on the path item at the top of the list
displays a pop-up menu with one item for every level in the current path, all the way to
the Disks list. Selecting any of these items takes you to the corresponding directory.
Command-O and Command-down-arrow are the Open button. In Save dialogs where
you enter a file name, Tab chooses between the edit line and the file list. Keystrokes
go to whichever one is active.
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Custom Dialogs

Before beginning a discussion on the individual items appearing in the pull
down menus of the menu bar, an overview of the two custom selection dialogs will be
presented. The first custom dialog is the file/directory selection dialog used for most of
the file utility routines, such as file copy and file delete. The second dialog is the device
selection dialog used for most device utility routines, such as disk copy. A thorough
understanding of these two very powerful dialogs will greatly facilitate the use of the
UtilityWorks disk and file utilities. Beginning with UtilityWorks version 2.0, the
appearance of these two custom dialogs will differ depending on whether System 6 is
present or not. When System 6 is present, the file/directory selection dialog is very
similar in both appearance and functionality to the System 6 Standard File Selection
dialog, including the use of icons in the lists of files and folders and the use of pop-up
menus to select any directory in the current path.
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File/Directory Selection Dialog

A new dialog has been developed to enable easy file selection and directory
selection for file operations. This dialog is used (in several different variations)
whenever UtilityWorks requires user selection of a directory or multiple files. The full
dialog consists of a left hand part (file selection) and a right hand part (directory
selection). Depending on the program’s requirements, either the full dialog, or just the
left hand or right hand part of the dialog, will be displayed. The full dialog title, as well
as the left hand and right hand dialog titles, explain the actions to be taken with the
selected items. Various dialog options (such as folder (subdirectory) creation) will only
be displayed when the need arises. The following discussion encompasses the full
selection dialog. Only the appropriate portions of this discussion will apply if just a part
of the total dialog is displayed. This dialog is very similar to the Apple Standard File
Operations Tool Set SFGetFile dialog used by many programs, except that it allows for
selection of multiple files and can have two file lists displayed in a single dialog box.

The left hand portion of the dialog allows the user to select an individual file or
multiple files and directories. Standard List Manager Toolbox protocols are used in the
selection process. Subdirectories are distinguished from files by a predecessor yellow
folder icon (with System 6) or a “:” symbol (for System 5.0.4). You can select a single
entry (file or subdirectory) by clicking on the entry (which will cause the entry to appear
in inverse video). Note that if an entry is a subdirectory, either double clicking on the
entry or using the Open button after selecting the entry will result in opening of that
subdirectory. This double clicking technique can also be used for finalizing the
selection of a single file. Double clicking on a file is equivalent to selecting the file and
clicking on Accept. Use the Accept, Data Fork, or Resource buttons to finalize
selections of either single or multiple files with this dialog. Multiple entries can be
selected in one of two different ways. The first way is to hold down the Apple key, and
click the mouse sequentially on each individual entry desired (all selected files and
directories will appear in inverse video). The second way (used mainly to select a
range of entries), is to click the mouse on the first entry, and, while holding down the
shift key, click the mouse on the last entry (the entire range selected will now appear in
inverse video). You can even use a combination of the above methods to make
multiple file and subdirectory selections. Clicking the mouse on any entry will cancel
your previous selections unless the Apple key or shift key are depressed at the same
time. With a little practice this multiple file selection process becomes very easy and
natural. You can also drop down to the next lower directory by clicking on the
pathname appearing immediately above either list. With System 6 this pathname is
replaced by a pop-up menu, with the current selection being the name of the directory
containing the files in the list immediately below the pop-up menu. Any directory in the
current path can be selected merely by selecting that directory in the pop-up menu.
Selecting the Disks entry is equivalent to clicking on the Disk button.

When System 6 is present, keyboard entries can be used to accomplish many
functions. When both the left hand and the right hand dialogs are present, the active
(target) dialog is indicated by a bold outline. The tab key will alternate between them.
Clicking the mouse on either list or pop-up menu will likewise select the target to
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receive the keypresses. Pressing the up or down arrow will move the selections in the
target list up or down. If the lists are sorted (alphabetized) you can also type one or
more characters, beginning with the first character, to jump the selection to the first
item in the list beginning with that sequence of characters. (To use the first several
characters of an item name, you have to type one letter every two-thirds of a second or
faster). When disks are displayed, the match is performed beginning with the second
character in the list (i.e.; the leading “:” character is ignored).

The files within the file selection dialog are nominally ordered alphabetically.
With System 6 the sort is non-case sensitive. Clicking on the Unsort button will display
both file/subdirectory lists in directory order. Clicking again on the Sort button will
revert to displaying both file/subdirectory lists in alphabetical order. The current
sort/unsort setting will remain in effect for all dialogs containing lists until it is changed
or the System is rebooted. The contents of different directories are shown by clicking
the mouse on the desired subdirectory and then clicking the mouse on the Open
button directly below the list of files, or by just double clicking on the desired
subdirectory. The Open button will disappear if there are no more subdirectories in this
tree branch. Pressing the Close button will drop down one directory level in the tree
branch until the root is reached, at which point a subsequent click of the Close button
will cause all on-line disks to appear. You can easily select the desired disk by either
double clicking on the desired disk, or selecting the desired disk and then clicking on
the Open button. The root directory of the desired disk will then appear. The pathname
of the current directory (the directory that contains the files and subdirectories
presented in the list) appears immediately above the list of files. With System 6 this
pathname appears as a pop-up menu. Selecting any entry in the pop-up menu will
open the indicated directory and display its list of files. If you are using an earlier
operating system, clicking the mouse on the pathname has the same effect as
pressing the Close button. In certain instances (e.g.; copying files) the total number of
blocks occupied by all files in the given subdirectory will be displayed immediately
below the list of files. This information is useful for determining if there is sufficient
space on your destination disk to copy the contents of the current selected directory. If
multiple subdirectory entries are selected when using the Open button, the first
subdirectory entry selected in the list will be used. To select another disk, press the
Disk button. All on-line disks will appear.

The files appearing for selection may be all files in the indicated directory, or a
filtered set of those files depending upon the function to be performed (e.g.; Clear
Backup Bit... will only display those files having the backup bit set, and Disable Desk
Accessories will only display those Desk Accessories currently enabled). The Backup
button, if present and pressed, will display for selection only those files whose backup
bit is currently set. This capability is most useful when making a partial backup of a
disk. Once pressed, the Backup button will remain in effect until you select another
disk or exit the dialog. The File Selection Dialog is a very powerful dialog capability.
The particular action taken with the files and directories selected is dependent on the
function to be performed, and will be discussed when the individual functions are
described.

The directory selection (right hand) portion of the dialog operates similarly to the
file selection portion, except that only a single entry may be selected. This represents
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the selected directory or the destination directory for the operation. To select a
directory you must both click on the selected directory and open it with the Open button
or double click on the selected entry. The selected directory will always appear
immediately above the directory list in the form of either a full pathname or a pop-up
menu depending on whether or not System 6 is present. The total number of unused
blocks on this disk will appear in certain instances (e.g.; copying files) immediately
below the directory list. The directory list is ordered alphabetically or by directory order
depending on the setting of the Unsort/Sort button. The directory list normally only
presents directories for selection. In certain instances you will also be presented with a
Show Files button. Clicking on this button will cause all files in the selected directory to
appear in the list. This is very useful for ensuring that the directory you selected has
the set of files you expected. Clicking on a file entry in this list normally has no effect
except with the Compare... menu item, where it is used to select the second file for the
compare operation when comparing two files of different names. The Open, Close,
and Disk buttons in the directory selection portion of the dialog operate exactly the
same as for the files selection portion of the dialog. You will be notified if the
destination disk is write protected if the operation to be performed requires writing to
the destination disk. With System 6 write protected disks are indicated by a Lock icon
appearing to the right of the pop-up menu(s) associated with the write protected disk.
In certain instances you will also be presented with a Folder button. Pressing this
button allows you to create a new subdirectory in the currently selected directory (right
hand portion of dialog), and automatically opens this subdirectory. When you click the
Folder button, you will be presented with a dialog box to enter the name of the new
subdirectory. Enter just the subdirectory name but NO pathname separators (“:” or “/”).
Any leading or trailing pathname separators (“:” but not “/”) are ignored. The System 6
JudgeName call (if System 6 is present) is used to ensure that the entered name is
consistent in syntax with the selected file system. If there are syntax errors, a
suggested alternative name is presented. A brief statement of the syntax rules for the
designated file system will also appear in the dialog. With both the left hand and right
hand dialogs, whenever you return to a directory containing a previously selected file
or directory (by using the close button or by selecting a menu item to perform the same
or another file or directory operation) the list will be centered on the previously
selected entry. This will minimize the necessity of scrolling through the list when
multiple operations are performed on the same file.

Several keyboard equivalents can be used with the file/directory selection
dialog. Command-period is equivalent to the Cancel button. Esc and Command-up-
arrow are equivalent to the Close button (moving the selected directory one level
closer to the root directory). Command-Esc or Command-D jumps to the Disks list.
Command-O and Command-down-arrow are equivalent to the Open button.

After all selections have been satisfactorily made, click Accept to initiate the
requested action. Accept will remain dimmed until at least one selection has been
made. Click Cancel to exit without performing the requested action. Click Data Fork (if
present in the dialog) to initiate the requested action (e.g.; copying files) on only the
data forks of selected files. Click Resource (if present) to initiate the requested action
on only the resource forks of selected extended files. The Data Fork button acts just
like the Accept button except when extended files are selected. If extended files are
selected, the Data Fork button performs the requested action on only the data fork of
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the extended file. The Resource button only has meaning for extended files, and
performs the requested action on only the resource fork of an extended file. The
Accept button performs the desired action on both the data fork and resource fork of an
extended file. This custom dialog is extremely powerful once you learn to use it. For
instance, with only a few clicks of the mouse you can initiate the copying of all files in
every directory of one disk to another disk or tree branch.

Since most users performing file operations normally perform several similar
operations in succession, UtilityWorks allows you to immediately return to the file
operation being performed upon completion of the current operation. Just hold down
the Command (Open-Apple) key as the current operation completes or when exiting
from the successful completion dialog. To discontinue the operation, press Cancel in
the file/directory selection dialog. Repetition of file operations will only occur with the
File menu’s Copy..., Move..., Delete..., Rename..., and Verify... operations, and then
only when the Command key is depressed..
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Device Dialog

The device selection dialog has been substantially changed in UtilityWorks
version 2.0. Radio buttons are no longer used. The new dialog contains a list of all on-
line devices and their disk names. Simply select the desired disk for the operation by
double clicking on the appropriate entry or by single clicking on the entry and clicking
on the Open Button. For disk Copy a single dialog with two lists (one for Source disk
and one for Destination disk) is now used in place of the previous separate dialogs.
The new dialog should simplify disk selection, especially if you have many on line
devices. The same new dialog is also used for selection of the printer device. Only
block devices are shown in this dialog, except when it is used to select the text printout
device or set device pathnames, in which case all non-block (character) devices are
displayed. Block devices are the only devices that can be used with the disk utilities. (A
complete list of all devices and device names appears in the Computer Info. window
when the Computer Info. menu item is selected).
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Device Polling

UtilityWorks version 0.9J and later incorporates continual polling of all block
devices containing removable media, except 5 1/4 inch drives. UtilityWorks will now
recognize whenever any removable disk (e.g.; 3.5 inch disks, CD ROMs, etc.) is
inserted or removed. The file/directory selection dialog will present a list of all currently
on-line disks if the disk appearing in either list is removed. As new disks are inserted,
they will also appear in the list of on-line disks. Similarly, the device selection dialog
will show the addition or deletion of a disk name as it is inserted or removed from a
drive. The Devices window will also be updated to reflect the current disk names as
disks are inserted or removed. When using System Disk 5.0.4 and later, the Standard
File Operations tool calls, used with such menu items as Open..., will also show the
insertion or removal of any removable disk other than 5 1/4 inch disks. Important! Do
not change any disks in any 5 1/4 inch drive after the device or file/directory selection
dialogs appear. If you need to make a 5 1/4 inch disk swap, press Cancel, make the
disk change, and start the process again. This is necessary because the complete set
of all devices are only polled immediately prior to creating the dialog, and 5 1/4 inch
drives will most likely not be polled again before the requested action is initiated. I
have tried to minimize the number of complete device polls used by UtilityWorks
because it does take time (especially when unformatted disks or 5 1/4 inch drives are
present). A capability has been added to remove a device (e.g.; 5 1/4 disks that take
excessive polling time) from this device poll through use of the Deactivate... menu
item. You can also set the slots for such devices to External (Your card) in the control
panel to eliminate the polling of such devices. A notification proc (new to System Disk
5.0) has also been added so that UtilityWorks will be told by GS/OS whenever it
detects a disk change (this is most useful with NDAs or tool calls that perform disk
operations).

UtilityWorks defaults (set in the Options... item of the Utilities menu) can be set to
disable the continual polling. This is advisable if you have any UniDisk  3.5 inch drives
(as opposed to Apple 3.5 inch drives) connected to your Apple IIGS. If you do not
disable the continual polling with UniDisks, the UniDisks will continually be turned on
and off, which is very distracting. If you do disable the polling, make certain you make
all disk changes prior to bringing up the file/directory selection dialogs. Note that the
Standard File Selection dialog (as used with the Open... item) will still poll all non - 5
1/4 inch drives including UniDisks. This should cause no problems since this dialog is
only present for a short amount of time. If you do have a UniDisk connected to your
Apple IIGS you will also note that the Finder will continually poll your UniDisk.

UtilityWorks version 2.0 added a new System 6 call to automatically poll most
devices (except 5 1/4 inch drives and tape backup units) once a second (this can be
inhibited in the Options menu item). If an unformatted disk is inserted, a dialog will
appear asking to either initialize (format) the disk or eject it. This call will detect disk
changes even when dialogs appear on the screen.
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Using the Text Editor Features

UtilityWorks version 0.9 and later uses the powerful Text Edit features of System
Disk 5.0.2 to give the user the capability of editing text based files using any desired
fonts, font sizes, font styles, font colors, and ruler settings. UtilityWorks also provides
the capability of saving or printing these resulting files as either text files or special
purpose files that retain all of the style information. The Apple TextEdit tool provides a
keyboard and mouse interface that supports a number of editing keys. The following
summarizes the effect of control keystrokes and mouse clicks in any UtilityWorks Edit
Text window:

Key Alias Description

Left Arrow Control-h Moves the insertion point to the pre-
vious character in the text.

Command key causes movement  by
word rather than by character.

Option key moves the insertion point
to the beginning of the previous line in
the text.

Shift key extends the selection from
current insertion point back by a char-
acter, word (if the Command key is
also held down), or line (if the Option
key is also held down).

Option key moves the insertion point
to the end of the current line in the
text.

Right Arrow Control-u Moves the insertion point to the next
character in the text.

Command key causes movement by
word  rather than by character.

Shift  key extends the selection from
the current insertion point forward by a
character, word (if the Command key
is also held down), or line (if the
Option key is also held down).



15

Up Arrow Control-k Moves the insertion point up one line.

Option key moves the insertion point
to the beginning of the document

Shift key extends the selection from
the current insertion point up by a line,
or page (if the Command key is also
held down), or to the beginning of the
document (if the Option key is also
held down).

Down Arrow Control-j Moves the insertion point down one
line.

Command key moves the insertion
point to the current column position on
the last line of the page.

Option key moves the insertion point
to the end of the document.

Shift key extends the selection from
the current insertion point down by a
line, or page (if the Command key is
also held down), or to the end of the
document (if the Option key is also
held down).

Delete Control-d If there is no current selection, re-
moves the character to the left of the
insertion point; if there is a selection,
removes the selected text.

Clear Clears the current selection (does
nothing if there is no selection) (same
as Edit menu Clear item).

Control-f or
del*

If there is no current selection, re-
moves the character to the right of the
insertion point; if there is a selection,
removes the selected text.

Control-y Removes all characters from the in-
sertion point to the end of the line, not
including any terminating ASCII return
characters ($0D).
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Control-x or
F2*

Cuts the current selection into the
Clipboard (same as Edit  menu Cut
item).

Control-c or
F3*

Copies the current selection into the
Clipboard (same as Edit  menu Copy
item).

Control-v or
F4*

Pastes the contents of the Clipboard
at the current insertion point, or  in
place of any selected text (same as
Edit menu Paste item).

UtilityWorks uses intelligent cut  and
paste, which eliminates the need for
the user to add or remove extra
spaces after pasting word-based
selections.

Click Moves the insertion point - dragging
selects by character.

Double-click Selects a word - dragging extends the
selection by words.

Triple-click Selects a line - dragging extends the
selection by lines.

home* Moves the insertion point before the
first character of the document.

end* Moves the insertion point after the last
character of the document.

page up* Moves the insertion point to the top of
the current page, then scrolls up a
page at a time for every key press.

page down* Moves the insertion point to the
bottom of the current page, then
scrolls down a page at a time for every
key press.

* Apple Extended Keyboard only (UtilityWorks 0.9.2 and later).

Note that when you select any of the characters e, i, n, u, and ` in combination
with the option key no immediate character is displayed. A second keypress will
produce one or two characters depending on what key is depressed. The
aforementioned key combinations are intended to produce proper foreign characters
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when used in combination with a vowel (a, e, i, o, or u) or certain other letters. The
resultant character will display as the selected letter with a special symbol appearing
above it.

Whenever the cursor is placed over the content area of a front Text Edit window,
the cursor is changed to an I beam cursor. Whenever a change is made to the contents
of a Text Edit window, the color of the title bar for that window will be changed from the
standard title bar colors (white text on black for the front window and black text on
white for all other windows) to special title bar colors (white text on red for changed
front windows and black text on orange for all other changed windows). The colored
title bars let you immediately see which windows have had their contents changed.
Saving a changed window as a Teach file with the Save As... menu item will result in
the window’s standard title bar colors being restored, and the window title being
changed to the name of the saved Teach file.

Whenever a Text Edit window that has been changed is closed (either by
clicking the Close box, selecting the Close menu item, or quitting UtilityWorks) a dialog
will appear asking the user if he wants to save the window. Selecting Save will save
the Text Edit window as a Teach file to its original pathname. The user is prompted to
select a pathname if the window is a New window and therefore does not have an
original pathname.
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Memory Utilization

UtilityWorks, like most Desktop applications, requires a considerable amount of
memory to run successfully. UtilityWorks requires at least 1 Megabyte of memory to
perform effectively, and will perform even better on computers having more than 1
Megabyte of memory. UtilityWorks can sometimes run on computers having less than
1 Megabyte of memory, but performance is very marginal. Users who have
considerably more than 1 Megabyte of memory and who are not using a :RAM5 disk
can largely ignore the following discussion; because, except in unusual situations,
they should not have significant memory problems.

Even though UtilityWorks version 0.8 and later is considerably larger than
earlier versions, in most instances the version 0.8 or later program will actually occupy
less computer memory. UtilityWorks now utilizes dynamic segments extensively. This
results in program segments only being loaded into memory as they are needed.
UtilityWorks versions 0.9K and later prohibits loading of any initial program segments
into special memory to avoid potential problems in establishing the SHR screen
memory. The purge routine will now optionally (and in some cases automatically)
unload and purge all dynamic segments as well as file descriptors (described below).
A memory window has been added which allows the user to continuously monitor
memory status. A Low Memory warning appears when the largest available memory
block drops below 64K. An Out-of-memory Queue (new to System Disk 5.0) has been
added to interface with the memory manager as it trys to create space for loading
program segments or establishing handles to memory. As currently implemented, this
queue provides a 64K reserve block of memory that is released only if a memory
request cannot be granted due to unavailable memory. This will provide sufficient
space for most toolbox calls, but may not provide enough space for loading new
program segments into memory in low memory situations. (You may see a fatal
Express Loader error in such situations). If the reserve block is deleted due to low
memory conditions (this is indicated by >> and << symbols in the memory window), it
may be restored (if at all possible) by running the memory purge routine. If you have
limited memory, monitor memory utilization carefully, avoid using the :RAM5 disk,
minimize the number of active Inits, CDAs, and NDAs (use the Utilities menu Loader
Actions... item to disable Setup files, CDAs and NDAs without actually removing them
from your disk), and purge memory frequently to minimize memory problems. When
launching UtilityWorks in such limited memory configurations, make sure UtilityLaunch
is non-restartable from memory, and purge memory on launch if at all possible.
Clearing the desktop will also provide additional memory (each window can have
more than 5 applications handles assigned to it). Certain UtilityWorks capabilities (e.g.;
Backup and Restore) provide automatic array sizing and memory purging based upon
the task to be performed and the amount of memory available. If the largest available
block of memory is less than 1.5 Megabytes, the Backup and Restore routines will
automatically unload and purge all dynamic segments and dispose of the file
descriptors. These routines will also optionally clear the desktop to maximize available
memory. If you choose to clear the desktop, UtilityWorks will also temporarily shut
down and unload the Standard File and Text Edit tools as well as dispose of the
internal icon handle to maximize available memory. Even with these precautions,
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however, there may still not be enough memory to backup and restore large hard disks
that have many files and directories. In such situations you will have to perform the
backup in two or more increments using tree branches rather than the whole disk, as
discussed below.

The amount of memory needed by UtilityWorks is determined by the functions
being performed. Any file being displayed in a window must be resident in the
computer’s memory. If you are displaying a number of large text files, a considerable
amount of memory will be required to hold these files. When decoding picture files,
AppleWorks files and Applesoft files, an additional program segment must be brought
into memory. Additionally, while actually decoding these files, a buffer of sufficient size
to hold the decoded file must be established. As soon as the file has been decoded,
the memory holding the original file image is released; but for a brief period of time
significant additional memory may be required. Closing any window releases all
memory, including the file image, associated with the window. File operations and
Backup/Restore operations are each contained in different program segments. A
memory buffer must be established when copying files to temporarily hold the data
being copied. The size of this buffer is determined by the largest available block of
memory. GS/OS itself requires a cache memory of at least 16K, and UtilityWorks
attempts to ensure that sufficient cache is available to GS/OS. Backup and Restore
operations also require a memory buffer, as well as blocks of memory to hold several
arrays that contain needed directory information. As mentioned previously, these items
are automatically sized based upon the contents of all directories contained on the
disk being backed up and the largest available block of memory. Best performance is
achieved when there is a large block of memory available. Additional memory will be
required by the Backup routine if the recommended Verify on Backup option is
selected.

When memory is limited, use the memory window, described in the UtilityWorks
Reference, to continuously monitor memory status. An extra line of information was
added to the memory window in UtilityWorks version 2.0. This line shows the
breakdown of how the currently used memory is divided between UWGS
(UtilityWorks), System (GS/OS Operating System, Loader, Tools, Drivers, etc.), Setup
Files, and Desk Accessories. This gives the user a better idea of how much of his
memory is being consumed by Setup files and Desk Accessories. If you are in a low
memory situation, disable unneeded Setup files and Desk Accessories using the
Loader Actions menu item in the Utilities menu. When the largest block drops below
64K, additional program segments may not be able to be loaded into memory. Even
though UtilityWorks will unload unneeded dynamic segments in low memory
situations, this may not create sufficient memory to load segments requiring large
amounts of memory.
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Finder Interface

UtilityWorks version 2.0 includes additional capabilities for interfacing with the
new System 6 Finder. The System 6 Finder uses rBundles to determine which icon to
display for any given file, and which program (if any) to launch when an icon is
selected. The System 6 Finder will automatically generate rBundles from the Finder
Icon files in the Icons folder unless the Finder Icon Files have been deactivated. These
rBundles are stored in the new Desktop file that is created in each disk’s Icons folder.
Many new applications designed for use with System 6  will contain their own
rBundles that specify the icons to use for the application itself plus any documents it
claims. UtilityWorks and UtilityLaunch now both contain rBundles that identify the icons
to use for both UtilityWorks or UtilityLaunch, as well as the files they own such as
UL.Menus. UL.BOOT, and UWGS.Backup files. The first time you execute these
programs with the new System 6 Finder, the Desktop file will be updated with this new
rBundle information. The rBundles allow applications to vote on who should handle
specific documents. For instance UtilityWorks can open many different types of
Graphics and Text documents and can save these documents in one of several
formats. As an example, UtilityWorks can open and display WordPerfect files. If
UtilityWorks is present, selecting a WordPerfect document with the Finder should result
in UtilityWorks being launched to display that file - that is unless WordPerfect itself is
present, in which case the user would probably prefer WordPerfect be launched to
display the file. The Finder resolves these apparent conflicts by allowing each
application to vote on specific files. If an application can only open a file (for instance
UtilityWorks can only open WordPerfect files) it is given the lowest priority for that file
type. If an application can write to the file it is given a higher priority.  If an application
can write to the file in the original file format it is given an even higher priority. If an
application owns a file (for instance WordPerfect owns WordPerfect document files) it
is given highest priority. Therefore, in the above example, if both UtilityWorks and
WordPerfect were present and had appropriate rBundles, selecting a WordPerfect
document would result in WordPerfect being launched because it has a higher priority.

Unfortunately, most applications do not currently have rBundles. Therefore, if
UtilityWorks were to claim a number of the documents it can open at the lower priority,
it would still be the highest priority for these documents because the true owner
applications do not have rBundles to claim the documents. To get around this problem,
UtilityWorks provides a capability to create a voting rBundle for any S16 application
you desire. UtilityWorks has a default rBundle that claims only the documents it owns
(namely its UWGS.Backup files). A separate Finder Preferences menu item has been
added to allow UtilityWorks to expand its own rBundle to add any or all of the
documents it can open. If UtilityWorks is launched from the FINDER as a result of
selecting one of its claimed documents, it will automatically and immediately display
the text or graphics file windows for each file selected in the FINDER, except when
Backup files are selected in which case the UtilityWorks Restore routine is immediately
executed.. Additionally, if print is selected in the Finder for these files, the files will also
automatically be printed.
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UtilityWorks also loads the FINDER’s file descriptor files when it first begins
execution. These files provide more descriptive information on the file type than the
typical 3 character mnemonic (which is still used in several UtilityWorks dialogs and
windows). File Descriptor information will appear in the Catalog window for every file
in the selected directory. It will also appear in the Set File Type dialog box, as well as
in the information bar of all windows opened by the Open... menu item. File descriptors
provide additional useful information, but also result in additional processing delays,
especially when displaying Catalog information of directories containing many files. If
you do not desire the file descriptor information, it can be eliminated, with associated
performance improvements, merely by selecting the Purge Memory menu item and
choosing to remove the file descriptors. The 3 character mnemonic will still appear.
Note that GS/OS itself only loads a subset of the file descriptor files in minimal memory
configurations.
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Printing and Saving the SHR Screen

At almost any point when running UtilityWorks (except when Alert Windows and
Error Windows are being displayed), you can print the current contents of the SHR
screen merely by pressing Command-H (Open-Apple-H). Command-H will print the
entire contents of the SHR screen, not just the contents of the windows. You can also
save the contents of the SHR screen as a Screen Image (Type $C1, AuxType $0000)
file by pressing Command-J (Open-Apple-J). A Standard File Save dialog will appear.
Simply select the directory and file name you desire to save the Screen Image under.
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Hard Disk Backup Warning!

A word of caution is in order when using any hard disk backup program. Any
backup disk can go bad over time, even if the disk verifies properly after it is written.
Always make multiple copies of any irreplaceable files, and never rely on any single
backup means for such critical files. For instance, when backing up my UtilityWorks
source files, I not only use the UtilityWorks Backup routine to backup these files, but I
also use the UtilityWorks File Copy routine to make an additional copy of these files on
another disk. Usually only a small subset of your hard disk files are truly irreplaceable.
A little extra effort in making multiple backups of these critical files may avoid great
disappointment at a later date.

You can use either the Backup routine’s Verify option or the Bulk Verify routine
to verify that the Backup disks have been properly written. The Backup routine’s Verify
option is preferable because it verifies each backup disk immediately after it is created,
and permits immediate retry of that backup disk on the same or another disk. The
Verify on Backup does, however, require additional memory that may not be available
on your computer. If you have insufficient memory, use the Bulk Verify routine to verify
your backup disks. If a UtilityWorks backup disk ever does go bad, you may be able to
salvage it by using a standard ProDOS disk recovery program, since the UtilityWorks
Backup routine creates standard ProDOS files. But first make a copy of the “bad”
backup disk using the UtilityWorks Disk Copy routine - and try putting it in another
drive than the drive showing the error when making the copy, if you have a second
drive. (Oftentimes a “bad” disk can be read correctly by a different drive. If you get no
errors during the disk copy, the copy should be good). Always note the file being
restored when a disk read error is displayed. You should still be able to do a Selective
Restore or a Full Restore of all remaining files using the recopied backup disk. (The
Disk Copy routine will skip bad blocks, after informing you of the error. Therefore, files
containing these bad blocks will be incorrectly restored). You will need to restore any
such files from your master or backup copies of the corresponding program disk. That
is the reason for making multiple copies of your irreplaceable files. Fortunately, in this
day and age very few disk errors occur if your equipment is properly adjusted and you
are using good quality disks. If you are ever concerned whether you still have a good
set of backup disks, you can always use the Bulk Verify or Disk or File Verify routines
to check the backup disks.

A reduced size version of UtilityWorks containing the UtilityWorks Restore program
(called UWGS.Restore) has been created and included on the UtilityWorks distribution
disk.  UWGS.Restore will easily fit on a single 800K System 6 Boot Disk, and includes
all of the UtilityWorks Restore capabilities, but none of the other powerful UtilityWorks
capabilities. It is designed to restore you hard disk boot partition from an 800K drive
using previously generated UtilityWorks Backup disks. An installation script has been
included to create the UWGS.Restore boot disk using the System 6 Installer and
System Disk 6.0 disk set.
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Note: UtilityWorks provides several possible methods of backing up a hard disk.
The standard Backup routine provides a capability of backing up any large hard disk
or hard disk partition to multiple 3.5 inch disks. If you have a spare hard disk or hard
disk partition of the same size or larger than the hard disk you desire to back up, you
can use the Copy... item in the Device menu to achieve a very rapid backup. This
same capability can be used with tape backup devices if you have appropriate drivers.
The resulting hard disk or hard disk partition will be identical to your original disk. If the
receiving disk is at least as large as the hard disk or hard disk partition to be backed
up, you can also use the Copy... item in the File menu to back up all files merely by
selecting all files/directories in the root directory of the disk to be backed up.
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SHAREWARE

UtilityWorks was previously a Shareware program. UtilityWorks is currently available
for free to those who register on the UtilityWorks Home Page
(http://www.wilde.org/UtilityWorks). Users who register on this page will receive an E-
Mail  which contains the Password to remove the initial Shareware Alert Dialog Box.

The current version of UtilityWorks is available for download at
http://www.wilde.org/UtilityWorks.
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COPYRIGHTS

UtilityWorks is Copyright © 1988-1998 by George R. Wilde. All rights reserved.

Copyright © 1987 TML Systems, Inc.
Certain portions of this software are copyrighted by TML Systems, Inc.

3200 Color Display Routine Copyright © 1990 by Jonah Stich, Bad Luck Software.

GIF LZW Decoder Copyright © 1987 by Steven A. Bennett.

GS/OS SYSTEM DISK Copyright © 1983-1993 by Apple Computer, Inc.

SOFTWARE LICENSE NOTICE

The software/documentation described herein is furnished under a nonexclusive
license and may be used only in accordance with the terms of the license. Any
unauthorized duplication or use of UtilityWorks software and or documentation, in
whole or in part, in print, or in any other storage and retrieval system is forbidden,
without the prior written permission of the author. This product is intended for your
personal use and may not be distributed commercially without the express written
permission of the author.
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WARRANTY DISCLAIMER

The author, George R. Wilde, makes no representations or warranties with respect to
the contents of UtilityWorks and its associated documentation, and disclaims any
liability or responsibility to the purchaser or any other person or entity with respect to
liability, loss, or damage caused or alleged to be caused directly or indirectly by this
software. Furthermore, the author reserves the right to revise this product, and to make
changes from time to time in the content hereof, without obligation to notify any person
of such revisions or changes.

APPLE COMPUTER, INC. (“APPLE”) MAKES NO WARRANTIES, EXPRESS OR
IMPLIED, INCLUDING WITHOUT LIMITATION THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, REGARDING
THE APPLE SOFTWARE. APPLE DOES NOT WARRANT, GUARANTEE OR MAKE
ANY REPRESENTATIONS REGARDING THE USE OR THE RESULTS OF THE USE
OF APPLE SOFTWARE IN TERMS OF ITS CORRECTNESS, ACCURACY,
RELIABILITY, CURRENTNESS OR OTHERWISE. THE ENTIRE RISK AS TO THE
RESULTS AND PERFORMANCE OF THE APPLE SOFTWARE IS ASSUMED BY
YOU. THE EXCLUSION OF IMPLIED WARRANTY IS NOT PERMITTED BY SOME
STATES. THE ABOVE EXCLUSION MAY NOT APPLY TO YOU.

IN NO EVENT WILL APPLE, ITS DIRECTORS, OFFICERS, EMPLOYEES OR AGENTS
BE LIABLE TO YOU FOR ANY CONSEQUENTIAL, INCIDENTAL OR INDIRECT
DAMAGES (INCLUDING DAMAGES FOR LOSS OF BUSINESS PROFITS,
BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, AND THE LIKE)
ARISING OUT OF THE USE OR INABILITY TO USE THE APPLE SOFTWARE EVEN IF
APPLE HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
BECAUSE SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF
LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE
LIMITATIONS MAY NOT APPLY TO YOU. Apple’s liability to you for actual damages
from any cause whatsoever, and regardless of the form of the action (whether in
contract, tort (including negligence), product liability or otherwise), will be limited to
$50.
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TRADEMARKS

UtilityWorks is a registered trademark of George R. Wilde.
UtilityLaunch is a trademark of George R. Wilde.

Apple, Apple IIGS, Macintosh, AppleWorks, Applesoft, ImageWriter, ProDOS,
and GS/OS are registered trademarks of Apple Computer, Inc.

ProSel is a trademark of Glen Bredon.

PC Transporter and TransWarp GS are trademarks of Applied Engineering.

Deluxe Paint II is a trademark of Electronic Arts.

PaintWorks is a trademark of Activision, Inc.

Printshop GS is a trademark of Broderbund, Inc.

816/Paint is a trademark of Baudville, Inc.

Publish It! is a trademark of Timeworks, Inc.

GraphicWriter is a trademark of Seven Hills Software

ORCA/M is a trademark of Byte Works, Inc.


